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Introduction

The term "ordinal” is applied to variables where the response measure of interest is measured
in a series of ordered categories. Examples of such variables include Likert scales and
psychiatric ratings of severity. Nominal and ordinal outcome models can be seen as
generalizations of the binary outcome model. The ordinal model becomes important when the
outcome variable is not dichotomous, or not truly continuous. If an ordinal outcome is analyzed
within a continuous model, such a model can yield predicted values outside the range of the
ordinal variable. As with binary data, some transformation or link function becomes necessary
to prevent this from happening. The continuous model can also yield correlated residuals and
regressors when applied to ordinal outcomes because the continuous model does not take the
ceiling and floor effects of the ordinal outcome into account. This can then result in biased
estimates of regression coefficients, and is most critical when the ordinal variable in question
is highly skewed. Armstrong & Sloan (1989) also report efficiency losses between 89% and
99% when comparing an ordinal to a continuous outcome, depending on the number of
categories and distribution within the ordinal categories.

Extensive work on the development of methods for the analysis of ordinal response data has
been undertaken by numerous researchers, including Hedeker & Gibbons (1994). These
developments have focused on the extension of methods for dichotomous variables to ordinal
response data, and have been mainly in terms of logistic and probit regression models. The
proportional odds model proposed by McCullagh (1980) is a common choice for analysis of
ordinal data. This model, which is described in detail in Section 2.2, is based on the logistic
regression formulation.

In this chapter we will now build on the dichotomous model discussed earlier and introduce
the ordinal model, illustrating the use of this model using the TVSFP (Flay, et. al., 1988) data
previously used in this manual.

2 Two-level ordinal analysis of TVSFP data

2.1 The data

The study was designed to test independent and combined effects of a school-based social-
resistance curriculum and a television-based program in terms of tobacco use and cessation.

The structure of this study indicates a three-level hierarchical structure. However, for
illustration purposes in this chapter we will consider a two-level structure in which students
are nested within schools. Data for the first 10 participants on most of the variables used in this
section are shown below in the form of a LISREL spreadsheet file, named tvsfpors.Isf, located
in the Multilevel Generalized Linear Model examples subfolder.



mtvsfpors.lsf E\@

School | Class |THKSord | THKSbin |PreTHKS| CC v | cev ||
1 403101.0 3.0 1.0 2.0 1.0 0.0 00 4
2 4030 4031010 40 1.0 40 1.0 0.0 00 _|
3 4030 4031010 3.0 1.0 40 1.0 0.0 0.0
4 4030 4031010 40 1.0 3.0 1.0 0.0 0.0
5 4030 4031010 40 1.0 3.0 1.0 0.0 0.0
6 4030 4031010 3.0 1.0 40 1.0 0.0 0.0
7 4030 4031010 2.0 0.0 2.0 1.0 0.0 0.0
8 4030 4031010 40 1.0 40 1.0 0.0 0.0
9 4030 4031010 40 1.0 5.0 1.0 0.0 0.0
10 4030 4031010 40 1.0 3.0 1.0 0.0 00

The variables of interest are:

o School indicates the school a student is from (28 schools in total).

Class identifies the classroom (135 classrooms in total).

o THKSord represents the post-intervention tobacco and health knowledge scaled score,
with 4 categories ranging between 1 and 4. The frequency distribution of the post-
intervention THKS scores indicated that approximately half the students had scores of 2
or less, and half of 3 or greater. In terms of quartiles, four ordinal classifications were
suggested corresponding to 0 — 1, 2, 3, and 4 — 7 correct responses.

o PreTHKS indicates a student's score prior to intervention, i.e. the number correct of 7
items.

o CcCisabinary variable indicating whether a social-resistance classroom curriculum was
introduced, where 0 indicates "no™ and 1 "yes."

o TV is an indicator variable for the use of media (television) intervention, with a "1"
indicating the use of media intervention, and "0" the absence thereof.

o CC*TVvwas constructed by multiplying the variables TV and CC, and represents the CC
by TV interaction.

O

In this example we will explore a random intercept model using the ordinal variable THKSord
as outcome. The original post-intervention score was assumed to be a continuous variable. In
contrast, here categories are created and the implied data collapse may lead to a loss of
information and thus results may differ from those obtained previously.

2.1.1 Exploring the data

The focus in this chapter is on the influence of the intervention on the tobacco health
knowledge scores of the students, as represented by the ordinal outcome variable THKSord. A
cross-tabulation of the variables CC, TV, and THKSord are given in Table 1.1 below.

In general, students not exposed to the social-resistance classroom curriculum (CC = 0) seem
to have less health knowledge than those students exposed to the social-resistance classroom
curriculum (cc = 1), regardless of their exposure to media intervention. The opposite is true
for students from groups assigned the social-resistance classroom curriculum (CC = 1).



Table 1.1: Crosstabulation of CC, TV and THKSord

TV CcC Total
0 THKSord 117 62 179
129 78 207
89 106 195
86 134 220
Total 421 380 801
1 THKSord 110 66 176
105 86 191
91 114 205
110 117 227
Total 416 383 799

The trend is also apparent when the post-intervention scores are expressed as proportions (see
Table 1.2 below).

First, notice that the outcome variable THKSord has a skewed distribution. By combining the
proportions per category over interventions, we find that 0.2219 of the 1600 students had a
value of 1 for THKSord, 0.2488 had a value of 2, 0.25 had a value of 3, and 0.2794 a value of 4
for THKSord. The monotonic increase in the proportion observed in each category of THKSord
indicates that it would be inappropriate to try to fit a continuous model to the data.

The pre-intervention scores of the students may be used as a covariate in the analysis. To get
some idea of the relationship between the scale score PreTHKS and the post-intervention score

THKSord, an exploratory graph may be useful.




Table 1.2: Observed proportion of high post—intervention scores

TV CcC Total
0 1

0 THKSord 1 0.0731 0.0388 0.1119
2 0.0806 0.0488 0.1294

3 0.0556 0.0663 0.1219

4 0.0538 0.0838 0.1375

Total 0.2631 0.2375 0.5006

1 THKSord 1 0.0688 0.0413 0.1100
2 0.0656 0.0538 0.1194

3 0.0569 0.0713 0.1281

4 0.0688 0.0731 0.1419

Total 0.2600 0.2394 0.4994

To take a closer look at the distribution of PreTHKS, select the Graphs, Univariate... option
from the File menu after opening the Lisrel spreadsheet tvsfpors.Isf.
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The Univariate plots dialog box is activated. Select the variable PreTHKS, and request a Bar
Chart. Click Plot.
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Figure 1.1: Distribution of the PreTHKS scores

Figure 1.1 is obtained. In contrast to the outcome variable THKSord, the distribution of the
PreTHKS score has a lower mean, with very few students exhibiting extensive knowledge on
the subject matter (PreTHKS =5 or PreTHKS = 6).

We now take a closer look at the distribution of the outcome variable at each distinct pre-
intervention score value by utilizing the Graphs, Bivariate option on the File menu. By default,
a bar chart will be produced. Select the variable THKSord in the Y column and the variable
PreTHKS in the X column, and request a Box and Whisker plot before clicking the Plot button.
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The figure below shows a reasonably steady increase in the mean THKSord with increasing
PreTHKS scores. This seems to be expected: students with more initial knowledge ending up
having higher post-intervention scores as well. Note that only 55 of the 1600 observations
showed a score of 5 or higher on the pre-intervention score, and that no student obtained a
post-intervention score of 7 out of 7.
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Figure 1.2: Box-and-whisker plot of THKSord for values of PreTHKS

Finally, we also take a look at the mean pre-intervention scores of the students for each of the
four subgroups. These are summarized in Table 1.3 below, and show that the mean pre-
intervention scores do not differ much.

Table 1.3: Mean pre-intervention scores

Study condition Mean

CC=0,TVv=0 2.152
CC=0,Tv=1 2.087
CC=1,Tv=0 2.050
CC=1,Tv=1 1.979



2.2 A multilevel ordinal model with logistic link function
2.2.1 The proportional odds model

The model we use for the analysis of ordinal data is based on McCullagh's (1980) proportional
odds model, which characterizes the ordinal responses in C categories in terms of C-1
cumulative category comparisons, specifically C —1 cumulative logits. The McCullagh model
can be written as

log P(y<c)
1-P(y<c¢)

}A—X'B

where

o c¢=1..,C-1 for the C categories of the ordinal outcome
o X isthe vector of explanatory variables, plus the intercept
o 7, represent the threshold parameter(s); and reflect the cumulative odds when x=0.

The positive association between a predictor variable x and the ordinal outcome variable y
is reflected by S . Itis assumed that the effect of x is the same for each of the cumulative odds
ratios.

To illustrate, consider a model with a single predictor x.The odds that the response is less than
or equal to ¢ (for any fixed c) is divided by e” for every unit change in X, as shown below:

{ P(y<c)

e}’c
()

On the other hand, the odds that the response is greater than or equal to ¢ (again for a fixed c)
is multiplied by e” for every unit change in X:

M —g x(eﬂ)x
P(y<c) '

To motivate the ordinal regression model, it is often assumed that there is an unobservable
latent variable (y*) which is related to the actual response through the "threshold concept."

An example of this is when respondents are asked to rate their agreement with a given
statement using the categories "Disagree,” "Neutral,” "Agree." These three options leave no
room for any other response, though one can argue that these are three possibilities along a
continuous scale of agreement that would also make provision for "Strongly Agree" and



"Disagree somewhat." The ordinal responses capture in y and the latent continuous variable
y* are linked through some fixed, but unknown, thresholds.

For the dichotomous model, one threshold value is assumed, while for the ordinal model, a
series of threshold values y,,7,,7,,....7c, Where C equals the number of ordered categories,

7, =—, and y. =o0, is assumed. Here, a response occurs in category ¢ (Y =c) if the latent
response process y exceeds the threshold value y._,, but does not exceed the threshold value
7. . The cumulative probabilities are given in terms of the cumulative logits with C —1 strictly
increasing model thresholds y,,7,,....7c_;. In the current case, we will thus have C-1 = 3

cumulative probabilities, given in terms of 3 thresholds y,, 7, and y,. The thresholds represent

the marginal response probabilities in the C categories. We will illustrate the use of the logistic
link function in this example.

To set the location of the latent variable, it is common to set a threshold to zero. Usually, the
first of the threshold parameters (y,) is set to zero. Alternatively, the model intercept (5, ) is

set to zero and C —1 thresholds are estimated.

2.2.2 The mixed-effect proportional model

The mixed-effect proportional odds model can be formulated as:

P(y<c) : :
Og[m} =7 _[XijB_'_Zijvi:"

In this model, as in the proportional odds model, the origin of the latent variable y is set by
setting the first threshold, y,, equal to zero. It is assumed that v; ~ NID(0,X,). The unit of

measurement is o = 7r/\/§ )

For this model, the category probabilities are defined as
P(y; <0) =y (7.~ (x;B+2v,))
and
P(yy =c)=v (7 —(x;B+2v,))—v (7er—(x;B+2v,))

where the cumulative standard logistic distribution function is



1
1+exp [—yc - (X;jl} +2,V, )] |

v (7 —(xB+zyv;))=

Various link functions may be used with this model. If we define G‘l[P(yij < c)] as

G_1|:P(yij < C)} =7c _(X‘ijB+Z‘iiVi) '
or, equivalently,
P(yij < C) =G D/c _(X'ijB_i_Z;iVi )]’

three types of models can easily be fitted:

o Using G™*(P)=log[ P/(1-P)]will give a cumulative logit model, i.e. a proportional
odds model,

o using G*(P)=®*[P/(1-P)] will produce a cumulative probit model, and

o using G™(P)=log [— log(1- P)] , the so-called complementary log-log link, will give
a proportional hazards model.

2.2.3 The mixed-effect non-proportional logistic regression model

A limitation of the model specified in the previous section is that it is assumed that the effect
of covariates is the same across the cumulative logits. To overcome this limitation, an
extension of the mixed-effects ordinal logistic regression model to allow for nonproportional
odds for a set of regressors was developed by Hedeker & Mermelstein (1998). This
generalization of the proportional odds model can be formulated as

P(y<c) |_ T - -

In this model, as in the proportional odds model, the origin of the latent variable y is set by
setting the first threshold, y,, equal to zero. It is assumed that v, ~ NID(0,X,). The unit of
measurement is o = /3.

u;j = hx1 vector for the set of h covariates for which the proportional odds is not assumed.
For this model, the category probabilities are defined as

P(yij <c)= '//(7c - (u‘ijgc +x;B+ Z'ijVi ))

e The effects of the u variables do vary across the c-1 cumulative logits

10



e The non-proportional odds model is a more flexible model for ordinal response relations

2.2.4 A general multilevel ordinal model

The multilevel ordinal model is defined in terms of the cumulative probability P(yij Sc)

where ¢ denotes the category of interest. The level-1 model is written in terms of the
cumulative logits, as shown below.

Level-1 model:

log [P(y‘—gc))} =7~ x;b; |-

1-P(y, <c

where X; represent the values of the covariates corresponding to level-1 unit j nested within
level-2 unit i.

Level-2 model:

If all the elements of the coefficient vector b, are allowed to vary randomly across level-2
units, then

b, =B+v,

which models the level-2 effects as a function of an overall mean p and a unique random
component v, ~ NID(0,X,). The latter is also referred to as the level-2 residuals and indicates

the extent to which a given level-2 unit differs from the average, as estimated by the first part
of the level-2 model.

Note that the level-2 model does not depend on the response variable. As the regression
coefficients £, B,, 5, and f, are without subscript, it is assumed that they do not vary across

the categories and hence that the relationship between the predictor variables and the
cumulative logits is not dependent on ¢. McCullagh (1980) referred to this as the assumption
of identical odds ratios across the C —1 categories.

In practice, a subset of the coefficients b, are assumed to have fixed, but unknown, values. For

example, a random intercept-and-slope model with 2 predictors of which the first has a random
slope would have a level-2 model of the form

11



By = By + Vs
br = 181 +Vy

i — P2

In this model, only the first two coefficients are assumed to vary randomly across the level-2
units.

Another characteristic of the current model is that a positive coefficient for a regressor indicates
that the odds that the response is greater than or equal to ¢ increases with an increase in
regressor values. However, another formulation as shown below, in which the regression
parameters B are identical but of opposite sign, is commonly used in survival analysis models

(see Chapter Error! Reference source not found.):

log e =y +[x'.b.] (c=1..,C-1).
1_ PIJC C 11 1 !

2.2.5 An ordinal model with 2 covariates and an interaction term

As in the case of the binary variable THKSbin, we intend to explore the relationship between
the type of intervention, the pre-intervention scores of students and the ordinal outcome
variable THKSord. We do so using a 2-level model, with students nested within schools.

Level-1 model:
At the first level, the pre-intervention score is used as predictor.

g[ P(THKSord, <c)

=» —|b.. +b.PreTHKS. j =1,...,n. subjects
1P(THKSordUSC)} 7B vy il Jects)

Level-2 model:

At the school level, the types of intervention (represented by the dummy variables CC and TV)
are used to explain differences in the intercepts of the groups. In addition, the interaction
between cC and TV is included in the model.

by = By + B,CC, + BTV, + B,(CC*TV). +v, (i =1,...,N groups)
by =/

It is assumed that v,; ~ NID(0,57).

The model can also be formulated in a single expression as:

12



) { P(THKSord, <c) }

1P (THKSord, <c)
=y, —[f, + BPreTHKS; + B,CC, + BTV, + B,(CC*TV). +v,,

Recall that the outcome variable has 4 categories. There are thus 3 thresholds. In this model

o 0-4, (remember that , =0 for identification purposes) is the first logit (category 1
vs. categories 2 to 4) for groups with no intervention (CC = Tv = 0). This logit is
adjusted for the effect of PreTHKS.

o y,—p, is the second logit, representing categories 1 and 2 vs. categories 3 and 4, for

groups with no intervention (CC = Tv = 0). This logit is also adjusted for the effect of
PreTHKS.

o 73— p, is the third logit, representing categories 1 to 3 vs. category 4, for the same
groups and again adjusted for the effect of PreTHKS.

o The coefficient S, represents the effect of PreTHKS on THKSord.

o The coefficient £, denotes the PreTHKS adjusted logit differences between cc = 1 and
cc =0 (for Tv=0).

o The coefficient S, denotes the PreTHKS adjusted logit differences between TV = yes
and Tv =no (for cc = 0).

o The coefficient S, is the adjusted difference in logit attributable to interaction between
ccand Tv (CC*TV).

o The random school deviation is represented by Vv, . Note that we assume a single, fixed
and thus common PreTHKS slope over the level-2 units.

o The interpretation of the coefficients is dependent on the coding of the variables used
in the model.

2.2.6 Setting up the analysis: Proportional Odds Model

Using the data in tvsfpors.Isf, we consider the situation where students are nested within
schools and fit a two-level model with the ordinal variable THKSord as outcome. We wish to
examine the relationships between the outcome and the two intervention methods employed,
simultaneously taking students' pre-intervention scores into account. To do so, we use the
model described above with schools as the level-2 units.

Use the File, Open Spreadsheet option to activate the display of an Open dialog box. Browse
for the file tvsfpors.Isf. Select the Multilevel, Generalized Linear Model option from the main
menu.

13



Data Transformation Statistics Graphs | Multilevel | SurveyGLIM  View Window Help

ﬂ_l ||§|EE| | | §|ﬂ| | Linear Model 3 i
Generalized Linear Model 4 Title and Options...
Mon-Linear Regression 4 ID and Weight...
[ wsfpors.st Distributions/Links..
School | Class |THKSord| THKSbin |PreTHKS| CU  Model Specification..
1 4031010 30 1.0 20 Random Variables..
2 4030 4031010 4.0 1.0 4.0 (s FR=) FR=)
3 403.00 4031010 30 1.0 40 1.0 0.0 0.0
4 403.00 4031010 40 1.0 30 1.0 0.0 0.0

We are now ready to provide model specifications by clicking on the Title and Options... menu
item. We opt to increase the number of quadrature points to be used during estimation. to 25
(default is 10).

Title:
TWSFP Ordinal, Students within Schoaols

kaximum MNumber of [terations: 100

0.0001
-999999
-999999

Conwvergence Criterion:

Missing Data Value:

Dependent Missing Walue:

Optimization Method

]

 MAFP (@ Cuadrature

MNumber of Quadrature Points: 25

Additonal Output
[ Besidual files

[ Mo data summary

[ Asymptotic covariance

MNext »»

Cancel | oK |

To build syntax, proceed to the Random YWariahles screen and click
the Finish button

Click the Next button to obtain the ID and Weight Variables dialog.

The School identification variable is used to define the hierarchical structure of the data, and is
selected as the Level-2 ID Variable from the Vvariables in data list.
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=
ID and Weight Variables

Yariables in data:

N [ | Level2Dverei

Class ISChDDI
THESord << Regmove

THKShin

PreTHKS

cC

T Add > Lewel 31D variahle:

CoTy I
<< Bemowve

Add »> Weight variable:

<< Remowve I

< Previous Mext»> Cancel oK

To build syntax, proceed to the Random Yariahles screen and click
the Finish button

To proceed to the Distribution and Links dialog click the Next button and select Multinomial as
the distribution type and Ordinal Logit as the link function type as shown below:

—
Distributions and Lin

Distribution type: IMuItianiaI

Link function:

Model terms: ISubtrad

Include intercept?

® Yes

Dispersion parameter

 Yes ® Fixedwvalue:

Estimate scale? I LI

<< Previous | MNext »» Cancel | Ok I

To build syntax, proceed to the Random YWariahles screen and click
the Finish button

15



Note (see the dialog above) that covariate and random effect means are subtracted from the
thresholds, implying that a positive coefficient indicates a positive association between the
outcome and the predictor in question. To add the covariate and random effect means instead
of using the default subtract setting, the add option must be selected in the Model Terms field
on the Advanced tab of the Model Setup dialog box.

By clicking the Next button on the dialog shown above, the Dependent and Independent
Variables dialog is displayed.

Start by selecting the ordinal outcome variable THKSord from the Variables in data list.
Complete the model specifications by selecting PreTHKS, CC, TV and CC*TV as the independent
variables (predictors).

- —

Dependent and Independent Var[abAIeL ﬁ

Yariables in data:
School Dependentwvariable:

Class
THESord
THESord << Bemove

THKShin
PreTHKS

cC
T PreTHKS

cc I
T I
COTY |

I

Ui

Independent variahles:

EwventYariable:

g(Previous| MNext »» | Cancel | Ok |

e f

To build syntax, proceed to the Random Yariahles screen and click
the Finish button

After selecting all the independent (explanatory) variables, the random effect(s) at level 2 must
be selected. This is accomplished by again clicking Next to proceed to the last dialog. In this
case, we wish to allow only the intercept to vary randomly over the schools. By default, the
intercept is assumed to vary randomly over higher levels of the hierarchy as indicated by the
checked boxes for the Include Intercept options.

16



Yariahbles in data Fandom Level 2

School [v Intercept
Class

THESord

THKShin Add >
E[';THKS << Remowve
To

CC Ty

Fandom Lewvel 3

[ Intercept
Add >>
<< Remove

Murnber of interactions: ID 3:
oK I

<< Previous Finigh Cancel |

To build syntax, click the Finish buttan .

tsfpors.PRL (=8 )

MGlimOptions Converge=0.0001 MaxIter=100 MissingCode=—9%999%99% ”
Method=Quad NQUADPTS=Z5 ModelTerms=sub;

Title=TVSFP Ordinal, Students within Schools;

SY="tvsfpors.lsf';

ID2=School;

DEPENDENT_MISS=—999999;

Distribution=MUL;

Link=0LOGIT;

DepVar=THESord;

CoVars=CC PreTHES TV 'CC*¥TV';

RANDOMZ=intcept;

Interactions=0;

Run the analysis by clicking the Run Prelis icon on the main menu bar.

File Edit Options Window Help
WEEFTENEETEELTE]
BIUS5S@ =

[ tvsfpors.PRL

Run PRELIS

2.2.7 Discussion of results

Portions of the output file tvsfpors.out are shown below.

17



The section shown below contains a description of the model specifications and of the number
of level-2 and level-1 units in the data.

[ tsfpors.oUT E= ol ™
o] o -
| TVSFP Ordinal, Students within Schools |
I I

0] (o]

m

Model and Data Descriptions

Sampling Distribution Multinomial

Link Function Cumulative Logit

Number of Level-2 Units 28

Number of Level-1 Units 1600

Number of Level-1 Units per Level-2 Unit =

23 25 26 70 31 42 52 55 39 33 52 65

27 80 33 18 34 38 67 73 70 T4 82 114

113 33 94 137 <

4 (1L} 4

Descriptive statistics

After the observation counts, descriptive statistics for all variables included in the model are
given.

Q==========================================================(
| Descriptive statistics for all the variables 1n the model |
Q==========================================================(
Standard
Variable Minimum Maximum Mean Deviation
THKSord1 0.0000 1.0000 0.2219 0.4156
THKSordz2 0.0000 1.0000 0.2487 0.4324
THKSord3 0.0000 1.0000 0.2500 0.4331
THKSord4 0.0000 1.0000 0.2794 0.4488
PreTHKS 0.0000 6.0000 2 0694 1.2602
CcC 0.0000 1.0000 0.4769 0.4996
™ 0.0000 1.0000 0.4994 0.5002
CC*Tv 0.0000 1.0000 0.2394 0.4268

18



Fixed effects results

The output describing the estimated parameters after convergence is shown next. Two
iterations were required to obtain convergence, using 25 quadrature points per dimension. The
likelihood function value at convergence as well as the deviance are also given, and may be
used to compare a set of nested models. The estimates are shown in the column with heading

Estimate and correspond to the coefficients £, 4, ..., B, in the model specification. Significant

effects of PreTHKS and CC are observed. With the exception of the CC *TV interaction term,
positive relationships between the predictors and the ordinal outcome variable are indicated by
these results. We also note that the coefficient associated with the curriculum-based
intervention (CC) is almost three times the size of the estimated coefficient for media
intervention (TV).

o] o

| Optimization Method: Adaptive Quadrature |

o] o
Number of quadrature points = 25
Number of free parameters = 8
Number of iterations used = 2
-21nL (deviance statistic) = 4239 .48553
Akaike Information Criterion 425548553
Schwarz Criterion 4298 50760

Estimated regression weights

Standard

Parameter Estimate Error z Value P Value
Thresh1 0.0885 0.1641 -0.5390 0.5899
Thresh2 1.1534 0.1656 6.9639 0.0000
Thresh3 2.3319 0.1734 13.4466 0.0000
PreTHKS 0.4033 0.0389 10.3780 0.0000
cC 0.9238 0.2041 4 5266 0.0000
v 0.2750 0.1977 1.3906 0.1643
CC*TV 0.4659 0.2846 -1.6371 0.1016

Odds Ratio and 95% Odds Ratio Confidence Intervals

Bounds
Parameter Estimate Odds Ratio Lower Upper
Thresh1 0.0885 0.9153 0.6636 1.2626
Thresh2 1.1534 3.1688 2.2904 43840
Thresh3 2.3319 10.2979 T.3304 14 4666
PreTHKS 0.4033 1.4967 1.3870 1.6152
cC 0.9238 2.5188 1.6884 3.7576
v 0.2750 1.3165 0.8935 1.9398
CC*TV 0.4659 0.6276 0.3592 1.0963

The alternative parameterization, setting threshold = 0 is shown next. The estimates of y, and
7, are 1.242 and 2.420 respectively — recall that for identification purposes y, was set to zero.
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Alternative Parameterization, setting Thresholdi= 0

Estimated regression weights

Standard
Parameter Estimate Error z Value P Value
intcept 0.0885 0.1641 0.5390 0.5899
Thresh2 1.2418 0.0571 21.7663 0.0000
Thresh3 2.4204 0.0748 323401 0.0000

Odds Ratio and 95% Odds Ratio Confidence Intervals

Bounds
Parameter Estimate Odds Ratio Lower Upper
intcept 0.0885 1.0925 0.7920 1.5070
Thresh2 1.2418 3.4619 3.0956 3.8715
Thresh3 2.4204 11.2502 9.7153 13.0277

Random effects results

The last part of the output file contains information on the random effects and calculation of
the intra-cluster correlation coefficient. The variation in intercept over schools is estimated at
0.0735, with the associated p-value of 0.055 indicating its statistical significance.

Estimated Tevel 2 variances and covariances

Standard
Parameter Estimate Error z Value P Value
intcept/intcept 0.0735 0.0383 1.9189 0.0550

Level 2 covariance matrix

intcept
intcept 0.073516

Level 2 correlation matrix

intcept
intcept 1.000000

Calculation of the intracluster correlation

residual variance = pi*pi / 3 (assumed)
cluster variance 0.0735

intracluster correlation = 0.0735 /7 ( 0.0735 + (pi*pi/3)) = 0.022
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In the case of the fixed effects, a 2-tailed p-value is used, as the alternative hypothesis
considered here is of the formH, : ##0. As variances are constrained to be elements of the
interval [0,+0), the p-values used for these effects are 1-tailed. If the model is true, it is
assumed that the level-1 error variance, o, is equal to z°/3 for the logistic link function,
where 7 represents the constant 3.141592654 (see, e.g., Hedeker & Gibbons (2006), p. 157).

Finally, the calculation of the intra-cluster correlation is shown. The value of 0.022 indicates
that almost all variation is attributable to students, rather than to the schools.

2.2.8 Setting up the analysis: Non-Proportional Odds Model

Use the File, Open and browse for the syntax file tvsfpors.prl (see Section 1.2.2.6):

D tvsfpors.PRL E@

MGTimOptians Converge=0.0001 MaxIter=100 MissingCode=-999999 =«
Method=Quad NQUADPTS=25 ModelTerms=sub;

Tit1e=TVSFP Ordinal, Students within Schools;

SY="C:\LISREL Examples\MGLIMEX\twvsfpors. 1sf"';

ID2=School ;

DEPENDENT_MISS5=-999999;

Distribution=MUL;

Link=0LOGIT;

DepVar=THKSord;

CoVars=PreTHKS CC TV 'CC*TV";

RANDOMZ=1intcept ;

Interactions=0;

11

Suppose that we want to check the non-proportional assumption for the variables cC and TV.
In this case we need to reorder the predictors (Covars) so that the variables cC and Tv are listed
first. Since there are two predictors of interest, we need to change Interactions=0 to
Interactions=2. The revised syntax file (saved as tvsfpors1.prl) is shown below:

[ tsfpors PRL =)

MGlimOptions Converge=0.0001 MaxIter=100 MissingCode=—99999p A
Method=Quad NQUADPTS=25 ModelTerms=sub;

Title=TVSFP Ordinal, Students within Schools;

SY="tvsfpors.lsf';

ID2=School;

DEPENDENT_MI 55=-999999;

Distribution=MUL;

Link=0LOGIT;

DepVar=THESord;

CoVars=CC TV 'CC*TV' PreTHES;

EANDOM2=intcept;

Interactions=2;
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Run the analysis by clicking the Run Prelis icon on the main menu bar.

File Edit Options Window Help
Dl & [w[5] %] S/0|7|

2 Run PRELIS

[ |j tvsfpors.PRL

2.2.9 Discussion of results

Portions of the output file Ttvsfpors1.prl are shown below.

Fixed effects results

The output describing the estimated parameters after convergence is shown next. Two
iterations were required to obtain convergence, using 25 quadrature points per dimension. The
likelihood function value at convergence as well as the deviance are also given, and may be
used to compare a set of nested models.

|: tvsfpors1.OUT E\@
Number of quadrature points = 25
Number of free parameters = 12
Number of iterations used = 2
-21nL (deviance statistic) = 4234 .01997
Akaike Information Criterion 4258 .01997
Schwarz Criterion 4322 55308

Estimated regression weights

Standard

Parameter Estimate Error z Value P Value
Threshi 0.1041 0.1694 -0.6144 0.5389
Thresh2 1.2148 0.1689 7.1919 0.0000 =
Thresh3 2.2643 0.1826 12.3976 0.0000
cc 0.9369 0.2224 4.2128 0.0000
v 0.2286 0.2106 1.0857 0.2776
CC*TV 0.4704 0.2841 -1.6556 0.0978
PreTHKS 0.4045 0.0389 10.4033 0.0000
Interactions of predictors with: Thresh2

cc 0.0952 0.1141 0.8341 0.4043
v 0.0716 0.1133 0.6323 0.5272
Interactions of predictors with: Thresh3

cc -0.1325 0.1460 -0.9073 0.3643
v 0.0444 0.1458 0.3045 0.7607
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Random effects results

The last part of the output file contains information on the random effects and calculation of
the intra-cluster correlation coefficient. The variation in intercept over schools is estimated at
0.0721, with the associated p-value of 0.058 indicating its statistical significance.

Estimated Tevel 2 variances and covariances

Standard
Parameter Estimate Error z Value P Value
intcept/intcept 0.0721 0.0381 1.8933 0.0583

Level 2 covariance matrix

intcept
intcept 0.072087

Level 2 correlation matrix

intcept
intcept 1.000000

Calculation of the intracluster correlation

residual variance
cluster variance

pi*pi / 3 (assumed)
0.0721

intracluster correlation = 0.0721 [/ | 0.0721 + (pi1*p1/3)) = 0.021

Testing the proportional odds assumption
For a pair of nested models, the difference in —2InL values hasa x> distribution, with degrees
of freedom equal to the difference in number of parameters estimated in the models compared.

From the information contained in tvsfpors.out (proportional odds model) and tvsfporsl.out
(non-proportional odds model) it follows that »*=4239.49 — 4234.02 = 5.47 with degrees of

freedom 12 — 8 =4. Since this is a non-significant result, we conclude that the proportional
odds assumption cannot be rejected.
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